
StrikeRisk v5.0
Getting started



Contents

StrikeRisk v5.0 – Getting started | Contents www.furse.com

1 Introduction 1

2 Installing StrikeRisk 2 – 7
2.1 System Requirements 2
2.2 Installing StrikeRisk 2 – 5
2.3 Installation troubleshooting 6
2.4 Uninstalling StrikeRisk 7

3 Activating StrikeRisk 8 – 13
3.1 Activating StrikeRisk – Overview 8 – 9
3.2 Activating Standalone (blue) dongles 10 – 11
3.3 Activating Network (red) dongles 12
3.4 Dongle Server setup 12 – 13

4 The User Interface 14 – 17
4.1 The user interface – Overview 14 – 15
4.2 Customising the user interface 16 – 17

5 Basic steps 18 – 21
5.1 Opening the program 18 – 19
5.2 Closing the program 20
5.3 Creating or opening a Project 20
5.4 Developing a Project 20 – 21
5.5 Developing Cases 21
5.6 Generating reports 21

6 Options 22 – 25
6.1 StrikeRisk Options – Overview 22
6.2 Interpolation of Kms values 22 – 23
6.3 Open last Project 23
6.4 Setting the Full report template 23 – 24
6.5 Setting the Summary report template 24
6.6 Setting the Case template 24 – 25
6.7 Setting the font colour for Risk results that are

acceptable or excessive 25



Introduction

1

Introduction | StrikeRisk v5.0 – Getting Startedwww.furse.com

StrikeRisk v5.0 is designed for engineers, architects and
contractors who are tasked with carrying out risk calculations in
line with BS EN 62305-2: 2006 Risk management.

BS EN 62305-2 is key to the correct implementation of BS EN 62305-3 and
BS EN 62305-4.

StrikeRisk is purpose designed to carry out the complex, laborious
calculations of BS EN 62305-2, results can be achieved in minutes rather
than the hours or days that it would take to do the calculations by hand.

The following are some of the key features of StrikeRisk v5.0

� Carry out and view multiple Cases (risk assessments) under the banner
of a single project.

� Build new projects from previously saved Cases.

� Create multiple Template files for standard Cases.

� Split the structure under consideration into multiple Zones in order to
pinpoint high risk areas.

� Consider multiple cables connecting to the structure.

� Consider multiple remotely connected structures.

� Quick and easy colour coded identification of risk factors requiring
attention.

� Full detailed reporting/exporting facility.

� Detailed Online help.

The next few topics will help you to get started with StrikeRisk.
You will be guided through:

� Installing StrikeRisk

� Activating StrikeRisk

� User interface

� Basic steps

� StrikeRisk options
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2.1 System Requirements
Before installing StrikeRisk v5.0 make sure your PC meets the
following minimum requirements. You need ...

Software

� Windows 2000, Windows XP or Windows Vista (complete with latest
service packs/security updates)

� Microsoft Internet Explorer 6.0

Hardware

� Pentium III PC (500MHz or higher recommended)

� 256 MB RAM (500 MB recommended)

� 200 MB available disk space

� USB port

� Super VGA (1024 x 768) or higher resolution video adapter and
17” monitor

2.2 Installing StrikeRisk
To install StrikeRisk v5.0, you’ll need to run the Setup program
contained on the CD-ROM. Perform the following steps to start
installation of StrikeRisk v5.0.

a. Insert the program CD in the CD-ROM drive of your computer. If your
system is set to run programs automatically, the following dialogue
box is displayed from which you can start the installation procedure. If
your system is set to run programs automatically, the dialogue box on
the next page is displayed for you to start the installation procedure.
You can then go to the relevant directory where you will find the file
Setup.exe. Select this file and click OK. Setup is then started manually.
Once the welcome screen of the Setup program is loaded, click Next to
continue with the installation.

If your system does not support the automatic execution of programs,
you can access the contents of the CD by selecting Start, Run and
Browse. You can then go to the relevant directory, typically StrikeRisk 5
(D:), where you will find the file Setup.exe. Select this file and click Ok.
Setup is then started manually. Once the welcome screen of the Setup
program is then loaded. Click Next to continue with the installation.
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b. A license agreement dialogue box will be displayed which should be
read carefully. The agreement specifies the legal conditions under
which you may install and use the StrikeRisk v5.0 software. If you agree
to the terms, click I accept the terms of the license agreement and then
Next to continue with the installation. If you do not agree with the
terms of the license agreement then click I do not accept the terms of
the license agreement and the installation wizard will exit.
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c. Information is requested from the user in the next dialogue box. Make
sure that you enter information in all fields so that installation can
continue. Click Next to carry on with the installation.

d. You are now asked to specify the destination folder for the installation.
The default path C:\Program Files\Furse\StrikeRisk 4.0\ is suggested. If
you click Next, you are accepting this default. If you wish to change the
destination folder, click Change. Specify your desired destination and
click Next to continue.
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e. The program is now ready to be installed. If you wish you can click
Back to return to previous setup dialogue boxes to review or change
the choices made. If all settings are correct, you can click Next to
continue the installation process and begin copying the files. The
progress bar indicates the current file transfer status.

f. A message is then displayed to inform you when Setup is successful.
You can choose to launch StrikeRisk immediately the installation is
finished by clicking the Launch StrikeRisk check box. Click Finish to
complete the installation.
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2.3 Installation troubleshooting
Occasionally, you may encounter problems while installing
StrikeRisk. Some troubleshooting tips are given below that may
resolve the problem. If you have any further questions, contact
Furse Technical Support.

� Check to make sure there is enough free disk space on your hard disk
to meet the system requirements. (The setup process should notify you
if there is not enough free disk space prior to installation.)

� Before installation, shut down any running programs, including
virus-checking programs. (Usually, virus-checking software has little or
no impact on the installation process; however, if you are running such
software and encounter difficulties with your StrikeRisk installation,
turning off the virus-checking programs and then re-installing often
resolves the problem.)

� Delete any files in your temporary folder. (This folder is determined by
the TEMP environment variable. Usually it is located in C:\Temp or
C:\Windows\Temp.)

� Run a disk-scanning utility. Hard disk errors can cause problems with
the installation process. (Some Microsoft Windows systems contain a
utility named Scandisk. If you have questions about disk-scanning
utilities, talk to your system administrator.)

� Copy the StrikeRisk setup CD to your hard disk, then run setup.exe
from your hard disk

� If you are using Windows NT, Windows 2000, or Windows XP, make
sure that you are logged into your machine as the local administrator
or as a user in the local administrator’s group.
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2.4 Uninstalling StrikeRisk
Furse recommends that you uninstall any older versions or
evaluation versions of StrikeRisk prior to installing new versions.
Running multiple versions of StrikeRisk applications on the same
computer is not recommended or supported by Furse.

Before uninstalling StrikeRisk

Use the following steps to protect existing information you may have on
your system.

Save existing StrikeRisk projects

Uninstalling removes program files only – project files you created in
StrikeRisk remain on your system. We do recommend, however, that you
copy and move any projects you saved in the StrikeRisk folder to another
location on your hard disk (such as in your My Documents folder) before
uninstalling StrikeRisk .

Save existing StrikeRisk templates

If you made changes to existing StrikeRisk templates and want to preserve
the styles, save a copy of the template in another location on your hard
drive (such as in your My Documents folder) before uninstalling StrikeRisk.

To uninstall StrikeRisk:

a. From the Start menu, select Settings – Control Panel.

b. Double-click on Add/Remove Programs.

c. Click the Install/Uninstall tab, if your version of Windows has it.

d. From the list of programs that you can remove, select StrikeRisk v5.0
(or StrikeRisk if uninstalling version 4.0).

e. Click Add/Remove.

f. At the prompt, click Yes to confirm that you want to remove
the program.

g. The uninstall program removes program files, folders, and
registry entries.

h. When the files are removed, the uninstall program indicates that
the process is complete. Click OK.
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3.1 Activating StrikeRisk – Overview
StrikeRisk is activated by a USB Security Key (sometimes known as
a hardware lock or a dongle). Product activation ensures that a
particular product is not used on more computers than is allowed
by the end-user license agreement (EULA). Activation is simple and
takes only a moment.

A full licensed copy of StrikeRisk is supplied complete with a dongle. The
dongle must be activated to allow StrikeRisk to run beyond its 15 day
evaluation period. The following activation procedures are specific
to either:

� Standalone dongles

� Network dongles

Standalone dongles

Standalone dongles are blue in colour.

Standalone dongles are supplied when Furse Part No. SR500 is purchased.

A Standalone dongle is required to allow StrikeRisk to run (once the
evaluation period has expired) on a single workstation. The Standalone
dongle must be present and detected in a USB port of your PC to allow
StrikeRisk to run on that same PC.

For details of the activation process see Activating Standalone (blue)
dongles on pages 10 – 11.

One Standalone dongle
for each user of StrikeRisk
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Network dongles

Network dongles are red in colour.

Network dongles are supplied when Furse Part No. SR501, SR505, SR510 or
SR599 is purchased.

A Network dongle is required to allow StrikeRisk to be run (once the
evaluation period has expired) by multiple users concurrently on multiple
workstations up to a fixed number of licenses.

For details of the activation process see Activating Network (red) dongles
on pages 12 – 13.

DDNet application running on
the server constantly monitoring
licenses

One Network dongle on a server
allowing multiple users of StrikeRisk
up to a fixed limit

DinkeyNet path on server is a
path (folder) to which all users of
StrikeRisk have access eg.
X:\Shared files\StrikeRisk License

Activating StrikeRisk | StrikeRisk v5.0 – Getting Started
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3.2 Activating Standalone (blue) dongles
a. Place the Standalone (blue) dongle (hardware lock) into an empty USB

port of your PC. If your operating system is set up to recognize new
hardware automatically, the following dialogue box is displayed from
which you can start the activation procedure. Choose not to connect to
Windows Update to search for software and click Next.

b. Choose to install the USB Security Key software automatically and
click Next.
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c. The USB Security Key will be configured. The following dialogue box is
displayed. Click Finish to close the USB Security Key Activation Wizard.
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3.3 Activating Network (red) dongles

Overview

The Network (red) dongles can be connected to any machine (not
necessarily a server) that is running any version of Windows, Linux
or Mac OSX. We refer to this machine as a dongle server.

The dongle server needs access to a path (folder) that can also be accessed
from all the workstations that you would like StrikeRisk to run from. We
refer to this path as the DinkeyNet path. The DinkeyNet path (folder) can
be on any machine on the network, including the dongle server (except if
you run DDNet as a service – see below). DinkeyNet will create a
sub-directory off this path. The workstations will need full access rights
(including read/write/create/delete) to the path.

NOTE 1: If the DinkeyNet path is located on an NT/2000/XP/Vista workstation then the
Operating system will not allow more than 10 simultaneous network users (5 for XP
Home). If you want to allow more than 10 network users the DinkeyNet path should
be located on the Server.

3.4 Dongle Server setup
Driver installation

a. You will need to install the appropriate drivers (using Setupdrv.exe) to
the dongle server only. You do not need to install the drivers to the
workstations that will run StrikeRisk.

b. Copy the file Setupdrv.exe from D:\Dinkey\Setupdrv.exe (where D: is
your CD drive) onto the dongle server

c. Run the file Setupdrv.exe.

Insert the Network dongle

a. Place the (red) Network dongle into an empty USB port of the dongle
server. If the operating system is set up to recognize new hardware
automatically, a dialogue box is displayed from which you can start the
activation procedure. Choose not to connect to Windows Update to
search for software and click Next.

b. Choose to install the USB Security Key software automatically and
click Next.

c. The USB Security Key will be configured. A dialogue box is displayed.
Click Finish to close the USB Security Key Activation Wizard.

NOTE 1: This part of the process is identical to that followed for a standalone dongle.
See Activating Standalone (blue) dongles
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Create a DinkeyNet path

a. Create a directory on the server to which all users of StrikeRisk
will have access. We would recommend naming this folder
\StrikeRisk License.

b. For example if the server has a mapped drive labelled X:\ and there is
already a folder on this drive (to which all users have access) named
X:\Shared Files, create a sub folder called \StrikeRisk License. The
DinkeyNet path is now defined as X:\Shared Files\StrikeRisk License.

Running DDNet

The DDNet program needs to be running on the dongle server for dongle
checking to function. It can be run as a Windows program or as an NT
Service. In general we recommend it is run as a Windows program because
it has greater functionality. DDNet should be loaded when the operating
system boots up. You can do this by adding DDNet to the Startup Group.

a. Copy the file DDNet.exe from D:\Dinkey\Setupdrv.exe (where D: is your
CD drive) onto the dongle server

b. Run the file DDNet.exe by double clicking the DDNet icon.

c. When DDNet is run for the first time it will prompt you to link a
DinkeyNet path with any dongle that it has detected.

d. Click the Browse button and search for the DinkeyNet path e.g.
X:\Shared Files\StrikeRisk License.

e. Click Done.

f. The DDNet icon appears in the system tray.
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4.1 User interface – Overview
The StrikeRisk user interface consists of the following main parts:

Title bar

The Title bar, which is a horizontal area at the top of the StrikeRisk
window, provides the filename of the currently Open Project.

Menu bar

The Menu bar is located at the top of the StrikeRisk window and contains
the names of the individual menus of the application. To open a menu, click
it with the mouse or press the ALT key together with the underscored letter
in the menu name (for example ALT + F for File). Each menu displays a list
of commands. Some of the commands have images next to them so you can
quickly associate the command with the image. Some menu items branch
into submenu items (for example Maps). If suspension points (...) appear
after a menu item (for example for File, Open Project), this means that a
dialogue box is opened when you execute the command. Shortcut (or pop-
up) menus are available when you right-click text, objects, or other items.

Case paneActive caseTitle bar

Menu bar

Toolbar

Project
explorer

Case
explorer

Summary
pane

Status bar
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Toolbar

The Toolbar contain buttons with images (the same images you see next to
corresponding menu commands) that can be used to directly execute
frequently used commands. The function of a button is displayed when you
position the mouse pointer over a button and hold it there for a short time.
If a button is greyed out, this means it is not available at present. StrikeRisk
includes a Standard Toolbar that you can show and hide as needed. By
default, the Standard Toolbar is docked below the Menu bar.

Project Explorer

The Project Explorer displays the status and make up of an open Project file.
The Project Explorer shows all of the Case files that make up the current
Project, whether Cases are open or closed and whether or not Cases require
saving.

Case Explorer

The Case Explorer lists all aspects of the currently selected (open) Case. The
Case Explorer can be used to accomplish tasks such as adding or removing
Structures, Lines and Zones. The Case Explorer also provides an easy means
of navigating through a Case.

Summary pane

The Summary pane displays the key results of the currently selected (open)
Case. All four primary risks are shown along with their direct and indirect
components. Risk results are colour coded to quickly identify if they are
higher (red) or lower (green) than their tolerable value. By default, the
Summary pane is located at the bottom of the StrikeRisk Window.

Status bar

The Status bar is a horizontal area at the bottom of the StrikeRisk window.
It provides the full path and filename information about the currently
selected Case.

Case pane

The Case pane is the area in which all currently open Cases are shown.

Active Case

The Active Case is the currently selected (open) Case and is displayed in
front of any other open Cases.
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4.2 Customising the user interface
You can change the program’s user interface based on your preferences.
The View menu provides options for hiding and displaying toolbars, panes,
and other WYSIWYG (What you see is what you get) elements. Here are
some ways of customizing the work environment:

� Adjusting pane size

� Moving Toolbars

� Open or close a Toolbar

� Open or close the Summary pane

Adjusting pane size

The program’s user interface is divided into three main areas (panes):

� Explorer pane

� Case pane

� Summary pane

You can adjust the widths of the Explorer and Case panes to make them
smaller or larger by:

a. Place the pointer over the edge of the divide between the two panes.
The pointer turns into a line with arrows on each end´.

b. Press the left mouse button and drag left or right. The pane is resized
after you release the mouse button.

The program maintains these settings until you adjust the panes again.

The Explorer pane is divided into two main areas:

� Project Explorer

� Case Explorer

You can adjust the relative heights of the two Explorers to make them
smaller or larger by:

a. Place the pointer over the edge of the divide between the two
Explorers. The pointer turns into a Line with arrows on each end .

b. Press the left mouse button and drag up or down. The pane is resized
after you release the mouse button.

The program maintains these settings until you adjust the panes again.

´
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Moving Toolbars

By default, all toolbars are displayed across the top of the window, below
the menu bar. You can move these toolbars to any location in the window.

To move a Toolbar:

a. Move your cursor somewhere over an area of the Toolbar that does
not display a button or drop-down list. A good place to point is the
title bar.

b. Press and hold the mouse button while you drag the Toolbar to a
suitable location in your window.

c. Release the mouse button to drop the Toolbar to its new location. It
will remain in this new place until you move it again or close it.

Open or close a Toolbar

By default, the Standard Toolbar is open and displayed across the top of the
window, below the menu bar. You can open and close this (or any other)
Toolbar whenever necessary.

To open the Toolbar:

a. From the View menu, select Toolbar.

b. The open toolbar displays a check mark on the left.

To close the Toolbar:

a. From the View menu, select Toolbar.

b. The closed toolbar does not display a check mark on the left.

Open or close the Summary pane

By default, the Summary pane is open and displayed across the bottom of
the user interface, below the Explorer pane and Case pane. You can open
and close this Summary pane whenever necessary.

To open the Summary pane:

a. From the View menu, select Summary.

b. When open the Summary menu item display a check mark on the left.

To close the Summary pane:

a. From the View menu, select Summary.

b. When closed the Summary menu item does not display a check mark
on the left.
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5.1 Opening the program
After you install the program, a StrikeRisk icon is displayed on
your desktop. How StrikeRisk opens depends whether the
program has been activated or if it is running in evaluation mode.
To open StrikeRisk running in evaluation mode:

a. Double-click the StrikeRisk icon on your desktop. The following
dialogue box is displayed. At the top of the dialogue a message
indicates the number of days remaining before the program must be
activated to run.

b. Click Run the product (if the 15 day limit has not expired), then click Ok.

c. The program splash screen is displayed and the user interface is loaded.

d. Once the 15 day evaluation period has expired the option to Run the
product is disabled as shown in the following dialogue box. The program
must now be activated by a valid hardware lock before it will run.

e. Click Purchase the product, if you do not have a valid hardware lock,
then click Ok. Your web browser will open an take you to the
StrikeRisk pages of www.furse.com where you will find details about
purchasing StrikeRisk.
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To open StrikeRisk activated by a Standalone (blue) dongle:

a. Double-click the StrikeRisk icon on your desktop.

b. The program splash screen is displayed and the user interface is loaded.

To open StrikeRisk activated by a Network (red) dongle:

The first time that StrikeRisk is run:

a. Double-click the StrikeRisk icon on your desktop.

b. The following Product Activation screen will appear.

c. Click Network License.

d. Click the Select Network License Folder button.

e. Browse to the location of the Network License (This location should be
advised to each user by the network administrator who activated the
Network dongle)

f. After a small delay the Run the product option will be enabled as
shown in the following dialogue box.

g. Click Run the product, then click Ok.

h. The program splash screen is displayed and the user interface is loaded.

Subsequently when StrikeRisk is run:

a. Double-click the StrikeRisk icon on your desktop.

b. The program splash screen is displayed and the user interface is loaded.
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5.2 Closing the program
From the File menu, select Exit.

NOTE: You may be prompted to update and or save files before the
program Exits.

5.3 Creating or opening a Project
Use the following procedure to create a new StrikeRisk Project or open an
existing Project.

To create a new StrikeRisk Project:

a. From the File menu, select New Project.

b. A new Project opens with a single Case (based on the Case template)
loaded.

To open an existing StrikeRisk Project:

a. From the File menu, select Open Project... The Open Project dialogue
appears.

b. In the Open Project dialogue, click the Look in dropdown box and
browse to the directory where your Project files are stored.

c. Select the required Project file.

d. Click Open. The chosen Project opens.

NOTE: To see examples of StrikeRisk Projects open the sample projects that
are included in the StrikeRisk installation. The sample projects are located
in the Samples subfolder of the location where you installed StrikeRisk.

5.4 Developing a Project
The following is a recommended strategy for developing a Project within
StrikeRisk. Not all of the tasks are necessary to develop a Project, but you
will probably want to complete most of them.

� Create a new Project

� Define the Project properties

� Develop an original Case

�� Define the Environmental influences

�� Define the Primary Structure (the structure under consideration)

�� Define any connected Secondary Structures
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�� Define any connected Lines

�� Define any Zones (areas) of the Primary Structure with common
characteristics

� Develop one or more solution Cases (if necessary)

�� Define any Protection measures

� Generate reports

5.5  Developing Cases
The heart of each StrikeRisk Project is its Cases. Each Case is a separate risk
assessment in its own right.

Each Case is used to carry out a series of calculations using relevant
formulae to determine the actual risk R for the Structure under review. 
The designer must ascertain/decide the type of losses relevant to the
structure, enter a number of dimensions and various weighting factors
relative to the Structure, along with various assigned values from the
appropriate tables in Annexes A, NB and NC of BS EN 62305-2. All of the
foregoing can be entered or is accessible within each Case.

The calculated risk R is then compared to its corresponding value of RT.

If the result shows R <= RT then the Structure is adequately protected for a
particular type of loss.

If the result shows R > RT then the Structure is not adequately protected for
the type of loss, therefore protection measures need to be applied. These
protection measures are determined from relevant tables given in 
BS EN 62305-2 (typically tables NB2 and NB3). Again these can be set within
each Case.

The aim, by a series of trial and error calculations is to ultimately apply
sufficient protection measures until the risk R is reduced below that of RT.

5.6  Generating reports
The ultimate aim of StrikeRisk is to produce the results of BS EN 62305-2
Risk Management calculations in a format that can be passed to a customer
or easily incorporated within the documentation of an engineering project.

StrikeRisk allows you to review/generate a number of different forms 
of output.
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6.1  StrikeRisk Options – Overview
A number of program options can be set via the Options dialogue which
can be accessed via the Menu.

To display Options dialogue using the Menu:

a. From the Tools menu, select Options. The Options dialogue opens.

The following program Options can be set:

� Interpolation of Kms values

� Open last report

� Full report template

� Summary report template

� Case template

� Setting the font colour for Risk results that are acceptable or excessive

6.2  Interpolation of Kms values
This StrikeRisk option allows the user to switch between two methods of
determining the factor PMS based on the result of factor KMS. The factor can
be either a) be taken directly from Table NB.4 of BS EN 62305-2 by choosing
the nearest tabulated value or b) determined by graphical means following
linear interpolation of the ranges given in Table NB.4 of BS EN 62305-2. The
latter method will lead to a more accurate assessment of factor PMS.
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To set the Interpolation of Kms values option:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Interpolation of Kms values tick box (a tick is now displayed).

To remove the Interpolation of Kms values option:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Interpolation of Kms values tick box (the box is now empty).

6.3  Open last Project
The Open last Project option allows the user to run StrikeRisk and
automatically load the last opened Project.

To set Open last Project option:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Open last Project tick box (a tick is now displayed). When
StrikeRisk is next opened the last Project will be automatically loaded.

To remove Open last Project option:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Open last Project tick box (the box is now empty). When
StrikeRisk is next opened no project will be loaded. 

6.4  Setting the Full report template
The Full report template is used every time a report is generated from the
Report tab of an open Case with the Full Report option set in the Report
tab toolbar. The Full report template may be altered to allow for different
types of project or different clients. Report templates may only be altered
via a licensed copy of Business Objects Crystal Reports software.

To set a new Full report template:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Full Report button. The StrikeRisk Report Template
dialogue appears.

c. In the StrikeRisk Report Template dialogue, click the Look in dropdown
box and browse to the directory where your Template files are stored. 
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d. Select the required Template file.

e. Click Open. The chosen Template and full path are displayed.

f. Click Apply.

6.5  Setting the Summary report template
The Summary report template is used every time a report is generated from
the Report tab of an open Case with the Summary Report option set in the
Report tab toolbar. The Summary report template may be altered to allow
for different types of project or different clients. Report templates may only
be altered via a licensed copy of Business Objects Crystal Reports software.

To set a new Summary report template:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Summary Report button. The StrikeRisk Report Template
dialogue appears.

c. In the StrikeRisk Report Template dialogue, click the Look in dropdown
box and browse to the directory where your Template files are stored. 

d. Select the required Template file.

e. Click Open. The chosen Template and full path are displayed.

f. Click Apply.

6.6  Setting the Case template
The Case template is used every time a new project is started (with a single
default Case) or a new Case is added to a project. The Case template may
be altered to take into account the standard components and details that
are common to all risk assessments a user wishes to make. Multiple
templates may be created to allow for different types of project or
different clients.

For example the standard template shipped with StrikeRisk sets up a case
with no Lines and one internal Zone. The user may wish to start all new
projects with two default Lines (power and telecom) and two Zones
(outside the structure and inside the structure). The user may also wish to
set certain default details e.g. the identification for the two Lines, the soil
resistivity, the Project properties, the Case name etc.

To create a new Case template:

a. Create a new project. For more information see the Create a new
Project topic from the online help system.
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b. Open the default Case ‘Original case‘. For more information see the
Opening a Case topic from the online help system.

c. Build the required default Case i.e. change the relevant parts of the
Case to the values that will become the new default. For more
information see the Building a Case topic from the online help system.

d. Save the Case to the StrikeRisk Templates folder ‘C:\Program
Files\Furse\StrikeRisk 5.0\Templates\’. For more information see the
Saving a new Case topic from the online help system. Give the file a
new name rather than overwriting ‘New solution.src’. 

e. Close the Project without saving the Project file. For more information
see the Saving a new Project topic from the online help system.

To set a new Case template:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options – Overview.

b. Click the Case Template button. The StrikeRisk Case Template
dialogue appears.

c. In the StrikeRisk Case Template dialogue, click the Look in dropdown
box and browse to the directory where your Template files are stored.

d. Select the required Template file.

e. Click Open. The chosen Template and full path are displayed.

f. Click Apply.

g. Now try creating a new Project and examine the default Case.

6.7  Setting the font colour for Risk results that
are acceptable or excessive

The colour selection chosen is used in the Summary Pane, the Case Explorer
and the Component Risk tab of a Case every time a result is less than
(acceptable) or greater than (excessive) its tolerable risk.

To set the font colour for Risk results:

a. Open the Options dialogue box. For more information see 
StrikeRisk Options - Overview.

b. Click the Colour selection, tolerable risk button for either acceptable or
excessive risks. The Windows Colour dialogue appears.

c. In the Windows Colour dialogue, choose a colour from either the basic
colours or click Define Custom Colours and choose a custom colour.

d. Click Ok. An example of the chosen colour is displayed

e. Click Apply to close the options dialogue.
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